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ã  ã  ã Introducing Rational TestFactory
Welcome to Rational TestFactory. You’re about to discover how TestFactory brings 
a new level of advanced automation to software quality testing.

Rational TestFactory is the next-generation automated software quality tool tha
automatically generates scripts that thoroughly test applications written in 
Microsoft® Visual Basic®, Microsoft Visual C+ + ®, and Java, as well as Java applets. 
TestFactory amplifies your productivity by dramatically reducing the manual effort 
required to test software. Because it automatically models an application, builds 
regression test suites, and finds defects, you can start using TestFactory at any phase 
in the development cycle. You can generate scripts that flush out defects and provide 
extensive product coverage as soon as your application has a user interface to test.

TestFactory builds on Rational Robot’s capabilities to develop and run regressi
tests that validate specific paths through an application. It takes advantage of th
advanced object recognition and playback features of Robot, and measures the
product coverage its scripts provide. TestFactory also provides detailed coverage
on scripts created in Robot.

This release of TestFactory is designed for testing 32-bit applications written in J
C+ + , and Microsoft Visual Basic (versions 4.0, 5.0, and 6.0). TestFactory and 
TestAccelerator run on the following Microsoft Windows platforms:

ã Microsoft Windows N T® 4.0

ã Microsoft Windows® 95

ã Microsoft Windows® 98

ã Microsoft Windows® 2000
1
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TestFactory Features

TestFactory offers the following features:

ã Automatically creates and maintains a detailed map of controls and actions in the 
user interface of your application.

ã Lets you map and test every available path in a functional area of the 
application-under-test.

ã Automatically generates scripts that provide extensive coverage of your 
application’s source code.

ã Tracks executed and unexecuted source code and reports its findings.

ã Automatically generates regression Test Suites containing scripts that unco
serious defects in your application.

ã Simplifies maintenance of test assets, which means that testing new builds
requires minimal effort.

ã Lets you organize scripts into Test Suites and run them as batch jobs.

ã Lets you quickly compose scripts that simulate user action sequences to inc
the validity of your test assets.

ã Provides code coverage data for Robot-recorded scripts, which you can inc
in your TestFactory Test Suites.

ã Together with TestAccelerator, lets you run multiple Test Suites, Pilots, an
scripts simultaneously on the Test Lab machines that you set up.

ã Together with the Test Code Changes add-in for Visual Studio, lets you ru
scripts that test changed source code files from within the Visual Basic or 
Visual C+ +  development environment.
2



ã  ã  ã About This Tutorial and the 
Sample Application

This tutorial is designed to get you up and running on TestFactory within a few 
hours. The examples take you through a sequence of tasks that you can perform later 
on your own application using TestFactory.

This tutorial contains information about how to use TestFactory to do the following:

ã Instrument the source code of a sample application written in Visual Basic.

ã Map the user interface of the sample application.

ã Run Pilots that test selected regions of the application.

ã Create Test Suites to run multiple scripts as batch jobs.

ã U se the AutoPilot to run multiple test objects.

ã U se TestFactory together with its ancillary program Rational TestAccelerator to 
run tests on a Test Lab machine.

N O TE: Please be sure that Microsoft Visual Studio 6.0 (Service Pack 2) or higher 
version is installed on your system. If it is not, you will not be able to run the 
tutorial.
3
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About the Tutorial Examples

This tutorial contains a section that describes how to install the sample application 
you’ll use throughout the tutorial, as well as seven example sections. Each exa
gives you instructions for completing one or more tasks that you would perform
during the course of a TestFactory project. The following table lists the example
the tutorial and the tasks that you’ll complete as you go through each one.

Because software quality testing is an iterative, cyclical process, the tasks describ
these examples represent ongoing efforts that you will perform again and again
your application develops and as new builds become available. As you work wit
your own application, you’ll find that you return to earlier tasks to remap a port
of the application, fine-tune selected regions of the application map, reconfigure
rerun TestFactory reports, and run Pilots to generate new scripts.

Section Tasks

Installing the Sample Application Install the Classics sample application.

Example 1: Starting TestFactory 
and Instrumenting the 
Application-Under-Test

Start TestFactory, enter project information in the N ew 
Project Wizard, and instrument the Classics source files.

Example 2: Mapping the 
Application-Under-Test

Incrementally map the Classics application. Set up 
interaction objects to map beyond a login dialog box, and 
to map a specific path in the user interface. Map an 
unmapped control. Exclude a control from mapping. U se 
the Find Objects window to locate objects in the 
application map. Create TestFactory reports.

Example 3: Automatically 
Generating Scripts

Edit data entry styles for testing input controls. Set up and 
run Pilots to test functional areas of Classics, and then 
examine the Pilot run results.

Example 4: Mapping a Secondary 
Application

Map a secondary application that the main 
application-under-test loads and executes. 

Example 5: Creating and 
Running a Test Suite

Create a Test Suite, run it on your local machine, and 
examine the run results.

Example 6: Using the AutoPilot to 
Run Multiple Pilots, Scripts, and 
Test Suites

Add Pilots, scripts, and Test Suites to the AutoPilot 
window, and then run the queued test objects on your 
local machine.

Example 7: Running Tests on a 
Test Lab Machine

Start and set up TestAccelerator on a Test Lab machine. 
Set up TestFactory to use Test Lab machines, and then 
run a Pilot, a Test Suite, and test objects listed in the 
AutoPilot on a Test Lab machine.
4
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In addition to this tutorial, we encourage you to take advantage of the TestFactory 
Project Assistant . The Project Assistant opens after you start TestFactory and enter 
project information in the N ew Project Wizard. You can use it at any time to quickly 
access useful information about basic TestFactory tasks.

About the Sample Application

The sample application that you’ll use with this tutorial is called Classics Online. It was 
developed using Microsoft Visual Basic 6.0. Classics Online is designed to let 
customers of a music retail chain store browse through an online catalog and p
orders, and to let store managers track inventory. When the Classics Online 
application is completed, tested, and successfully deployed, it will provide autom
order entry and fulfillment capabilities for the retail chain.

Classics Online is a work in progress. It consists of the main Classics application
a secondary application called Inventory, which the main application loads and 
executes. Three builds of Classics (A, B, and C) and two builds of Inventory (B and
C) are included in the Classics Online folder, which is copied to your system when
you install Rational Suite TestStudio. The examples in this tutorial use the Class
build of the main application and the InventoryC build of the secondary applicat
You’ll learn how to access the application files in the next section of this tutorial
5
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ã  ã  ã Preparing to Use the Tutorial

Objectives

ã Install the Classics sample application.

ã Run two utilities so that you can work with the sample application.

Installing the Classics Sample Application

To install Classics and its secondary application, Inventory:

1 . Click Start → Program s → Rational Suite TestStudio → 
Rational Test → Set U p Rational Test Samples.

2 . Clear the check boxes for sample applications that you do not want to install, and 
leave the Classics O nline check box selected.

3 . Click N ext.

4 . To complete the installation, click Finish.
7
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After you install Classics, you can find the application files in the following directory:

\\Program Files\Rational\Rational Test 7\Sample Applications\ 
Classics Online\classics source (or \inventory source)

Making Post-Installation Adjustments

After you install Classics, and before you try to use the application, you must run the 
Vbcmpfix.exe file to correct a minor Microsoft Visual Basic problem, and run the 
Vbctrls.reg file to update the system registry.

The following steps are necessary only for using the Classics sample application. You 
do not need to perform these steps before you work with your own applications.

Running the Vbcmpfix.exe File
To run the Vbcmpfix.exe file:

1 . Open the following directory:

\\Program Files\Rational\Rational Test 7\Sample Applications\Classics Online

2 . Double-click the Vbcmpfix.exe file.

3 . Click Fix Insta ll.

4 . Click Q uit.
8
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5 . Click O K .

6 . Click O K. Although a message advises you to reboot your system now, don
it just yet.

Locating and Running the Vbctrls.reg File
To locate and run the vbctrls.reg file:

1 . Locate the vbctrls.reg file on the Visual Basic 6.0 CD-ROM or the Visual Studio
6.0 CD-ROM. For Visual Basic 6.0, you can find the vbctrls.reg file in the 
\Common\Tools\Vb\Controls folder on Disk 1. For Visual Studio 6.0, you ca
find the vbctrls.reg file in the same folder on Disk 3. 

2 . Copy the vbctrls.reg file to your machine.

3 . Double-click the file name.

4 . On the Registry Editor message box, click O K.

Restarting the System
After you run the Vbcmpfix.exe and vbctrls.reg files, be sure to restart your system.

What’s Next

You're now ready to begin working with the Classics sample application in 
TestFactory. The remaining examples in this tutorial take you through the bas
steps needed to complete the tasks described. For more complete information 
the processes described, see the Using Rational TestFactory manual and 
TestFactory Help. 

The next section shows you how to start TestFactory, specify project informatio
the N ew Project Wizard, and then instrument the Classics source code files.
9
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ã  ã  ã E  X   A   M   P  L  E   1  

Starting TestFactory and Instrumenting 

the Application Source Code Files

Objectives

ã Start TestFactory and log on to the Classics project in the Classics Repository. 

ã U se the N ew Project Wizard to supply TestFactory with basic information 
about the Classics application and project.

ã Instrument the Classics source files.

Scenario

This example shows you how to instrument an application so that TestFactory can 
calculate code coverage values for your scripts when you start testing. The following 
exercises show you how to start TestFactory, use the N ew Project Wizard to supply 
basic project information, and then instrument the source files for the Visual Basic 
sample application Classics.
1 1



Start ing TestFactory and Instrum enting the Applica tion  Source Code Files
Starting TestFactory and Opening the Classics Project

Before you start TestFactory, quit all applications open on the desktop.

1 . To open the Rational Repository Login dialog box, click Start  → Program s → 
Rational Suite TestStudio → Rational TestFactory. 

2 . In the U ser ID  box, type admin.

3 . Leave the Password box empty.

4 . In the Repository Path list, click C:\Program  Files\Rational\Rational Test 7 \ 
ClassicsRepository.

Alternatively, browse to the path where you installed Rational Suite TestStudio.

5 . In the Project list, click CLASSICS.

6 . Click O K .

TestFactory initializes the CLASSICS project by building a U I library of object 
classes, and placing the Application Map folder, the Robot Scripts folder, and the 
U I Library folder in the left pane of the TestFactory window.

Rationa l Repository 
Log in d ia log box

Type admin here.
12



Entering In form ation in  the N ew Project W izard
Entering Information in the New Project Wizard

After you open a project in TestFactory for the first time, the N ew Project W izard 
prompts you to provide information about the application and project.

1 . Read the information provided on step 1 of the N ew Project Wizard, and then 
click N ext .
1 3



Start ing TestFactory and Instrum enting the Applica tion  Source Code Files
2 . In the Executable box on step 2, type or browse to the following path:

C:\Program Files\Rational\Rational Test 7\Sample Applications 
\Classics Online\ClassicsC.exe

3 . Click N ext.

TestFactory uses the executable file name you provided to determine that 
ClassicsC is written in the Visual Basic programming language.

Enter the path  
to the 
ClassicsC.exe 
file here.

Leave
Source code 
selected.

Leave
Visual Basic 
selected.
14
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4 . U nder Program m ing language, leave Visual Basic selected.

Later in this example, you’ll instrument the Classics application. 
Instrumentation gives TestFactory the information it needs to determine h
well your scripts exercise the application source code during testing. You c
instrument a Visual Basic application by using the object code method or the 
source code method. For this exercise, you’ll use the source code method.

5 . U nder Instrum entation, leave Source code selected.

6 . Click N ext.

7 . To close the wizard, click Finish.

After the N ew Project Wizard closes, the Project Assistant opens. You can use the
Project Assistant to quickly get information about instrumenting the application
mapping the user interface, and running a Pilot.

Click here
to close the 
wizard .

Click here to  learn 
how to instrum ent an 
applicat ion.

Click here to  learn how 
to m ap an application .

Click here to learn how to 
create and run a Pilo t 
that autom atica lly 
generates scrip ts that test 
your applicat ion.
1 5



Start ing TestFactory and Instrum enting the Applica tion  Source Code Files
For now, close the Project Assistant.

To open the Project Assistant later, just click H elp → Project Assistant.

Instrumenting the Sample Application

On step 3 of the N ew Project Wizard, you selected the source code method for 
instrumenting the Classics application. The following steps show you how to 
instrument the source files. Later, when you test the application, TestFactory Pilots 
will use the instrumented source files to calculate code coverage— the percentage of 
all source code that your scripts cover.

To instrument the Classics source files:

1 . On the TestFactory toolbar, click Instrument.

Add bu tton

Path to  your 
Visual Basic 
program
16



Sum m ary
2 . U nder Project selection, click Add.

3 . In the Open dialog box, browse for and open the ClassC.vbp file. You can find 
this file in the following directory:

\\Rational Test 7\Sample Applications\Classics O nline\classics 
source\ClassC.vbp

4 . U nder O ptions for rebuild, leave the Rebuild after instrum enting source 
check box selected.

5 . If the Path to Visual Basic value is incorrect, enter the correct path of the 
executable file for your Visual Basic program.

6 . To instrument the source files and rebuild the ClassicsC.exe file, 
click Instrument.

7 . After instrumentation is completed and the executable file is rebuilt, click Close.

Summary

In this example, you started TestFactory, used the N ew Project Wizard to provide 
TestFactory with basic project information, and then instrumented the Classics 
source files. TestFactory can now use the instrumented source files to calculate code 
coverage values for the scripts that you create later as you run Pilots to test 
the application.

What’s Next

In the next example, you’ll learn how to create and begin to develop a detailed 
application map of the Classics user interface.
1 7
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ã  ã  ã E  X   A   M   P  L  E   2  

Mapping the Sample Application

Objectives

ã Start the Classics application from TestFactory and explore its user interface.

ã Map Classics to single-level depth.

ã Assign a style with a required string case to an object in the application map so 
that TestFactory can map beyond a login dialog box.

ã Map a region of the Classics application to full depth.

ã U se an interaction object to map an alternative path in a functional area of the 
sample application.

ã Map an unmapped image control.

ã Exclude a control from mapping and testing.

ã Map Classics to full depth.

ã U se the Find O bjects window to locate an object in the application map.

ã Create TestFactory reports on objects in the application map.

TestFactory uses TrueMap technology to automatically gather detailed information 
about the user interface and its navigational pathways. TestFactory completely 
exercises an application and builds a comprehensive hierarchical application map. In 
TestFactory, a well-developed application map provides the elements for automatic 
script generation.
1 9
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Scenario

In this example, you’ll learn how to map the Classics sample application in 
increments. Some of the exercises describe tasks such as creating a region obje
excluding a control from mapping, that you might not need to perform when yo
work with your own application in TestFactory. These exercises are meant to 
demonstrate some of the methods you can use to fine-tune the application ma

Starting Classics from TestFactory

Before you begin mapping, start the Classics application from TestFactory and
explore its user interface so that you can see what you’ll be mapping.

To start and explore Classics from TestFactory:

1 . On the Standard toolbar, click StartAU T.

2 . In the Full N am e box under Account Info, type D atabase Admin.

3 . In the Password box, type 5 5 55 .

4 . Click O K.

Classics Login d ia log box
20
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5 . Try out the various options in the Classics O nline window to see where they 
lead you and how the application functions.

After you finish exploring the Classics user interface, and before you start 
mapping, be sure to quit Classics.

6 . To quit Classics, click File → Exit.
2 1
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Incremental Mapping

You can use TestFactory’s Application Mapper to map an application to full depth 
or single-level depth. In full-depth mapping, the Application Mapper exercises an
maps every control it encounters in the application until it has taken every path i
find. In single-level depth mapping, the Application Mapper exercises the first 
control it encounters and then maps the controls that this interaction exposes 
without exercising them. In this example, you’ll map regions of the Classics use
interface in increments by alternately using single-level and full-depth mapping

Mapping Classics to Single-Level Depth
When you map the application the first time, the Application Mapper can access
map the Classics Login dialog box, but it cannot exercise the controls in it. With
the correct login information to pass to the application, the Application Mapper
cannot expose any more of the user interface. In this exercise, you’ll start by map
Classics to single-level depth. Later, you’ll specify login information to expose m
of the user interface for TestFactory to map.

To map Classics to single-level depth:

1 . To start the Application Mapper Wizard, click Application M apper on the 
Standard toolbar.

Step 1  of the Applicat ion  
M apper W izard
22
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2 . Click N ext.

3 . Click N ext.

4 . U nder Begin where and go how far, click Single level.

5 . To close the wizard and start mapping, click Finish.

As mapping begins, you’ll see the following events on the screen:

ã The TestFactory window closes and the Application Mapper progress bar o
at the bottom of the screen.

ã A mask covers the screen and displays the Running Application Mapper message.

Because you specified 
the Classics executable 
file in  the N ew Project 
Wizard , TestFactory 
knows where to  find the 
file for m apping.

Step 2  of the Application  
M apper W izard

Click here to  specify 
sing le-level depth  
m apping.

Step 3  of the App licat ion  
M apper Wizard

The f irst t im e you  m ap 
an applicat ion , the 
default  “ < < Root> > ”  is 
the appropria te start ing  
point. A fter you  m ap the 
AU T the f irst t im e, you  
can  choose any U I 
object in  the m ap as the 
starting object.
2 3
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ã TestFactory starts Robot and then minimizes the Robot window.

ã TestFactory starts Classics, and then exercises its controls.

During the mapping process, the Application Mapper progress bar displays 
information about mapping activity.

This first, single-level mapping session takes just a short time. After the session is 
completed, the restored TestFactory window displays the new application map in the 
left pane and the contents of the M apping Summ ary report in the right pane.

The Mapping Summary report can display the number of new objects mapped, 
previously-mapped controls not seen in the user interface, the starting object for the 
mapping session, and other information that you’ll find useful in evaluating the n
map and developing it further.

To jump to a mapped object listed in the Mapping Summary report, double-click
report item in the right pane.

Stop button

T im e elapsed since 
m apping started

M apping status

N um ber of new 
objects found

M odified objects found

N O TE: Do not try to use the computer while TestFactory is mapping. Because
TestFactory uses the pointer to exercise controls in the application, it is especia
important that you not move the mouse during mapping.

M apping  Sum m ary 
report ob ject

D ouble-click here to  select the 
Classics Login object in  the 
applicat ion m ap.

M apping Sum m ary 
report conten ts
24
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Expanding the Application Map

A plus ( + ) character next to an object in the application map indicates that child 
objects are mapped below it. To expand an object and see its child objects, do one of 
the following:

ã To expand a branch of the map one level, click the plus (+ ) character next to an 
collapsed object.

ã To fully expand a branch of the map and see all of the objects mapped beneath it:

– Right-click the object, and then click Expand All on the shortcut menu.

– Click the object, and then click Expand on the Standard toolbar.

For now, click the Account Info object in the application map, and then click Expand 
on the toolbar.

The ComboBox and TextBox objects mapped below Account Info represent th
Full N ame and Password boxes, respectively, in the Classics Login dialog box.
make these objects easier to identify in the application map, you’ll rename them

To rename the ComboBox and TextBox objects:

1 . In the application map, click the ComboBox object.

2 . Press F2, and then type Full N ame in the active text box.

3 . N ext, click the TextBox object.

4 . Press F2, and then type Password in the active text box.

Click here to  expand the 
Accoun t In fo group box 
and view objects m apped 
one level benea th  it .

Com boBox object m apped for the Full N am e box 

TextBox object m apped for the Password box 
2 5
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Mapping Beyond the Classics Login Dialog Box

So far, you have mapped just the Classics Login dialog box and the controls that it 
contains. To map more of the Classics user interface, you must provide the 
Application Mapper with input to pass to the Full N ame combo box and the 
Password text box. To supply this information, you’ll assign data entry styles to
Full N ame and Password objects in the application map, and then edit the styl
that they include required string cases.

Assigning a Data Entry Style to an Object
This exercise shows you how to:

ã Assign data entry styles to input-type objects in the application map.

ã Edit the data entry styles to include required string cases.

Assigning Data Entry Styles to Objects in the Application Map
To assign a data entry style to the Full N ame object:

1 . In the application map, click the Full N ame combo box object.

2 . In the Properties view in the top right pane, click the Select Style box on the 
Style toolbar.

3 . In the Select Style list, scroll down to and click N ames-First and Last.

To edit the N ames-First and Last style and specify a required string case:

1 . To open the Edit Data Entry Styles dialog box, click Style Properties on the 
Style toolbar.

Style too lbar at the top of the 
Propert ies view

Select Style box
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The Edit Data Entry Styles dialog box shows the data entry settings for the 
N ames-First and Last style.

2 . To specify a required string case for TestFactory to pass to the Full N ame box 
during mapping and testing, under Settings, type D atabase adm in in the 
Required string case box.

3 . To save your setting and close the dialog box, click O K .
2 7
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To assign a data entry style to the Password object:

1 . In the application map, click the Password text box object.

2 . In the Properties view in the top right pane, click the Select Style box on the 
Style toolbar.

3 . In the Select Style list, scroll down to and click Strings-Alphanum eric.

To edit the Strings-Alphanum eric style and specify a required string case:

1 . To open the Edit Data Entry Styles dialog box, click Style Properties on the 
Style toolbar.

The Edit Data Entry Styles dialog box shows the data entry settings for the 
Strings-Alphanum eric style.

2 . To specify a required string case for TestFactory to pass to the Password box 
during mapping and testing, under Settings, type 5 5 55  in the Required string 
case box.

3 . To save your setting and close the dialog box, click O K .

N ow that you’ve supplied the Application Mapper with the information it needs
pass to the Classics Login controls, you can map the next level of controls.

To map the next level of controls beyond the Classics Login dialog box:

ã In the application map, right-click the OK button object, point to M ap It!, and 
then click Single Level on the shortcut menu.

This mapping session takes longer than the first one because TestFactory has 
to and can map more controls. 

Select Style box
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To view the results of the mapping session after mapping is completed:

1 . To jump to the O K button object in the application map, click Previous O bject 
on the toolbar.

2 . Click the plus character (+ ) next to the OK button object, click the plus 
character next to the LeftClick object, and then click the plus character next to 
the Classics Online window object.

The application m ap now includes objects 
that represent the first level o f contro ls in  the 
Classics O nline window.
2 9
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Comparing the Application Map to the Sample Application

After a mapping session is completed, you can start Classics from TestFactory and 
compare your mapping results against it. At the beginning of this example, you used 
the StartAU T  toolbar button to start Classics so that you could explore its user 
interface. After mapping, you can use the Go To “Cont ro l” in AU T  shortcut 
menu option to go to a specific control in the AU T.

Going to a Selected Control from the Application Map
The Go To “Cont rol” in AU T  option lets you select an object in the map and have 
TestFactory drive directly to the corresponding control in the application. To start 
Classics and navigate to the O rder I t! button in Classics:

ã In the application map, right-click the O rder It! button object, and then click 
Go To “O rder It!” in AU T .

On your screen, you’ll see:

ã The TestFactory window closes and the Go To Control progress bar open
the bottom of the screen.

ã A mask covers the screen and displays the Go To Control message.

ã TestFactory starts Robot and then minimizes the Robot window.

ã TestFactory starts Classics, and then exercises the user interface until it ex
the O rder It! button.

Once TestFactory locates the O rder It! button, the Go To Control progress bar 
closes and the TestFactory window is restored. The Classics application stays 
on top of the TestFactory window.

Take a few minutes to examine the application map hierarchy and check the acc
of its structure by exploring the navigational paths you’ve mapped so far. Click 
O rder It! and see where it takes you in the application. You’ll map the Order It! 
button next.

N O TE: Remember to quit Classics before you start the next mapping session.
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Mapping a Part of Classics to Full Depth

N ow that you’ve mapped the first level of controls in the Classics user interface,
can fully map a functional area of the application. The Order It! command butto
Classics opens the Make An Order dialog box, which a user can fill out to orde
albums. To correctly place an order, a user must enter quantity and payment 
information. 

To map the Make An Order dialog box and its controls, you’ll start by mapping  
Order It! button to single-level depth. 

To map the Order It! button to single-level depth:

ã In the application map, right-click the Order It! button object, point to M ap It!, 
and then click Single Level on the shortcut menu.

After mapping is completed, the Mapping Reports folder is selected in the left p
The right pane displays the contents of the Mapping Summary report.

To jump to the new Make An Order window object in the application map:

ã In the right pane, under N ew window objects, double-click M ake An O rder.

The O rder It!  button object

A fter a  m apping  session is com pleted, 
TestFactory d isp lays the con ten ts of 
the M apping Sum m ary report in  the 
right pane.

To go to the M ake An  O rder window object 
in  the applica tion m ap, double-click here.
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To see the child objects mapped below the Make An Order window object:

ã Click Expand on the Standard toolbar.

The Image view in the lower right pane displays a bitmap image of the Make An 
Order window.

The Place O rder button leads to three possible paths in Classics. If a user correctly 
enters quantity and payment information, and then clicks Place O rder, Classics 
displays the Order Confirmation message box. If the user clicks Place O rder 
without entering the correct payment information first, Classics displays the 
Incomplete Order error message. If the user types a zero in the Q uantity box, and 
then clicks Place O rder, Classics displays the Invalid Quantity O rdered error 
message. In the following exercises, you’ll map all three of these paths so that yo
test them later.

TestFactory has m apped the M ake An O rder window and 
the f irst level of contro ls (ch ild  objects) in  the window.

Place O rder button  object

The Im age view in  the lower righ t 
pane d isp lays a b itm ap im age of 
the M ake An O rder window.

Place Order button
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In this exercise, you’ll map the path that includes the Incomplete Order message bo

To map the Incomplete Order message box:

ã In the application map, right-click the Place Order button object, point to 
M ap It!, and then click Full on the shortcut menu.

To view the results after mapping is completed:

ã On the toolbar, click Previous O bject, and then click Expand. 

The application map now contains U I objects that represent the Incomplete O
message box and its child controls.

N ext, you’ll insert and set up interaction objects to map the paths that include 
Order Confirmation message box and the Invalid Quantity Ordered error 
message box.

Mapping Alternative Paths in an Application

An interaction object lets you guide the Application Mapper through a path in th
application that it cannot reach automatically. You can set up interaction object
guide TestFactory through all of the available paths in a functional area of the 
application. If you don’t use interaction objects, you can only map one of the pa
available to users. 

In the last exercise, you mapped the path to the Incomplete Order message b
Classics. In this exercise, you’ll map two alternative paths — one that includes 
Order Confirmation message box, and another that includes the Invalid Quan
Ordered message box.

To successfully order an album in Classics, a user must type text in the Q uantity, 
Card N um ber, and Expiration D ate boxes, and then click Place O rder. To map the 
Confirmation Order message box, you’ll set up an interaction object that includ
components for these controls.

Incom plete O rder m odal window object
3 3
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Before you insert the interaction object, rename the objects mapped for the text box 
controls to make them easier to identify in the application map.

To rename three of the text box objects in the application map:

1 . Click the 1 object.

2 . Press F2, and then type Q uantity in the active edit box.

3 . Expand the Payment Information object in the application map.

4 . Click the TextBox object.

5 . Press F2, and then type Card N um ber in the active edit box.

6 . Click the TextBox1 object.

7 . Press F2, and then type Expiration D ate in the active edit box.

Inserting an Interaction Object from the Insert Toolbar
To insert an interaction object from the Insert toolbar:

1 . On the left side of the TestFactory window, click Interaction O bject on the 
Insert toolbar.

2 . In the application map, click the Place O rder button object.

3 . To name the interaction object, type Confirm  O rder in the active text box.

Text box object m apped for the Card N um ber box

Text box object m apped for the Expirat ion D ate box

Text box object m apped for the Q uantity box

Interaction Object button on the Insert too lbar

Type Confirm Order here.
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The Interaction O bject view in the upper right pane lists the Place Order button as 
a com ponent  of the Confirm Order interaction object.

Adding Interaction Object Components from the Application Map
In this exercise, you’ll add the Quantity, Card N umber, and Expiration Date 
components to the interaction object from the application map. 

To add components from the application map:

1 . In the application map, leave the focus on the Confirm Order interaction ob
and then drag the Quantity object from the application map to the Interact
Object view. 

2 . Drag the Card N umber object, and then the Expiration Date object, from t
application map to the Interaction Object view.

The Confirm Order interaction object now contains the components that 
TestFactory needs to navigate to the Order Confirmation message box.

After you add the text box components to the interaction object, TestFactory as
the default Base style to each of them. N ext, you’ll assign new data entry styles to 
components, and then specify required string cases to include in each.

Place O rder com ponent in  the 
In teract ion O bject view

D rag the Q uantity object from  
the applicat ion m ap to the 
In teraction O bject view.

N O TE: Be sure that you drag the Quantity object, and that you don’t click it. 
O therwise, the Properties view replaces the Interaction Object view in the 
top right pane. If this happens, just click the Confirm Order interaction 
object and start again.
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To assign new styles to the interaction object components:

1 . In the Interaction Object view, click the Q uantity component, and then click 
Style Properties on the Interaction Object toolbar.

2 . U nder Style, click the N ame box, and then scroll down to and click 
N um bers-Integer.

3 . U nder Settings, type 2  in the Required string case box.

4 . To save your settings and close the Edit Data Entry Style dialog box, click O K .

5 . N ext, click the Card N um ber component in the Interaction O bject view, and 
then click Style Properties on the Interaction Object toolbar.

6 . U nder Style, click the N ame box, and then click Credit Cards.

7 . U nder Settings, type 5 5 5 5  55 5 5  5 5 55  5 5 5 5  in the Required string case box.

8 . To save your settings and close the Edit Data Entry Style dialog box, click O K .

9 . N ow click the Expiration D ate component, and then click Style Properties on 
the Interaction Object toolbar.

1 0 . U nder Style, click D ates in the N ame list.

1 1 . U nder Settings, type 1 2 /0 0  in the Required string case box.

1 2 . To save your settings and close the Edit Data Entry Style dialog box, click O K .

N ow that you’ve specified styles and required string cases for the text boxes, you
map the path to the Order Confirmation message box.

To map the Order Confirmation message box:

ã In the application map, right-click the Place Order object, point to M ap It!, and 
then click Full on the shortcut menu.

Style box in  the Edit  D ata En try Styles d ia log box

Type 2 here.
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To view the new objects in the application map after mapping is completed:

ã On the Standard toolbar, click Previous, and then click Expand.

N ext, you’ll set up an interaction object that lets you map the third path in this 
of Classics— the one that includes the Invalid Quantity Ordered message box. 
time, you’ll insert the interaction object using the Insert menu.

Inserting an Interaction Object Using the Insert Menu
To insert an interaction object using the Insert menu:

1 . In the application map, click the Place Order button object.

2 . Click Insert → Interaction O bject.

3 . To name the new interaction object, type Invalid Q uantity in the active text box.

Inserting a Component from the Image View
N ext, you’ll add the Quantity component to the interaction object by selecting i
the Image view.

To add the Quantity component to the interaction object from the Image view:

1 . On the Interaction Object toolbar, click Insert I tem .

The applicat ion  m ap now con ta ins 
both the Incom plete O rder m essage 
box and the O rder Confirm ation  
m essage box.

Type Invalid Quantity here.

Insert Item bu tton
3 7
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2 . In the Image view in the bottom right pane, point to the image of the Quantity 
text box, and then, after TestFactory outlines the image in red, click the image.

The Interaction O bject view now contains the Quantity component.

To specify a required string case value of zero for the Quantity component:

1 . Leave the Q uantity component selected in the Interaction Object view and click 
Style Properties on the Interaction Object toolbar.

2 . U nder Settings, type 0  in the Required string case box.

3 . To ensure that TestFactory uses only the required string case to exercise the 
Quantity text box during testing as well as during mapping, under Settings, 
clear the U se random entries check box.

4 . To save your settings and close the Edit Data Entry Style dialog box, click O K .

To map the path in Classics that includes the Invalid Quantity O rdered 
message box:

ã Right-click the Invalid Quantity interaction object, point to M apIt!, and then 
click Full on the shortcut menu.

In  the Im age view, point 
to and click the im age of 
the Q uantity text box.

Q uantity com ponent in  the 
In teract ion O bject view

Type 0 here.
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To view the results after the mapping session is completed:

ã On the Standard toolbar, click Previous O bject , and then click Expand.

The application map now contains objects for the Invalid Q uantity Ordered error 
message box and its child controls. You have successfully mapped the three paths 
available to a user from the Make An Order window.

Mapping an Unmapped Control

In some instances, the Application Mapper can fail to detect a control in the 
application. For example, the Album  tab in Classics contains an image control that a 
user can double-click to order the album displayed in the image. TestFactory do
see this image control. If you map the Album tab to full depth, the Application 
Mapper creates no new objects. To get TestFactory to see and map the contro
have to create a region object for it first.

In this exercise, you’ll insert and set up an image control that lets you map the 
Album tab to full depth.

To view the Album tab object in the application map, click the plus character (+
next to the Tab Control object.

To see the unmapped image control, click the Album tab object in the applicat
map. The Image view in the lower right pane displays a bitmap image of the 
Album tab.

Album  tab object
3 9
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Creating a Region Object
To create a region object for the unmapped image control:

1 . On the Image toolbar, click D raw Region.

2 . To select the region, drag the mouse from one corner of the album cover image 
to the opposite corner.

TestFactory places a green tracker on the area of the image you selected, and 
inserts the Region1  object below the Album object in the application map.

3 . To name the region object, click it, press F2, and then type Album  Cover in the 
active text box.

The A lbum  tab con ta in ing the 
unm apped im age con trol is d isp layed 
in  the Im age view.

Im age toolbar

A  green  tracker covers the region  
that you drew.

N ew region  object
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Setting the Action for Exercising a Region Object
To ensure that TestFactory uses the double-click action to exercise the image control 
on the Album tab, you’ll set the D oLeftD oubleClick property for the region object.

To set the DoLeftDoubleClick property:

1 . In the application map, click the Album Cover region object.

TestFactory displays the object properties groups in the Properties view in
top right pane.

2 . In the Properties view, click Application M apper to view the application 
mapper properties for the region object.

3 . In the Value list for the D oLeftD oubleClick property, select Yes.

4 . To save time during the mapping process, change the value set for the 
D oLeftClick property to N o.

Exercising the album cover image exposes new parts of the Classics user inter
Before you can test this part of the application, you need to map the Album tab
full depth.

To map the Tab Control box, including the Album tab, to full depth:

ã In the application map, right-click the Tab Control object, point to M apIt!, and 
then click Full.

The Properties view in  the top righ t pane

Applicat ion M apper propert ies in  the 
Properties view

DoLeftDoubleClick property
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To view the results after the mapping session is completed:

ã On the Standard toolbar, click Previous O bject , and then click Expand.

After it exercised the O K button, the Application Mapper encountered the Make An 
Order window. Because this window was already mapped, the Application Mapper 
placed a shortcut object that points to the window object originally mapped.

Excluding a Control from Mapping and Testing 

The Classics Adm in menu contains a command that we don’t want to map or te
The Restore D atabase command resets all customer, product, and order data in
Classics database. In this exercise, you’ll prevent TestFactory from exercising t
control by excluding it from mapping and testing. 

To expose the Restore D atabase command in the Admin menu:

ã In the application map, right-click the Admin menu object, point to M ap I t!, 
and then click Single Level on the shortcut menu.

Shortcut to  the 
M ake An  O rder window

Adm in  m enu  object
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To see the Restore Database object after the mapping session is completed:

ã Click Previous O bject , and then click Expand on the toolbar.

To exclude the Restore D atabase menu command from mapping and testing:

1 . Click the Restore Database object in the application map.

2 . In the Properties view, double-click the Value field for the 
ExerciseD uringM apping property, and then click N o.

3 . To see the Pilot properties, click Pilot in the Properties view.

4 . To exclude the Restore Database control from testing, double-click the Value 
field for the ExerciseD uringTesting property, and then click N ever.

When you fully map and test the Admin menu, TestFactory will ignore the 
Restore D atabase menu command.

Restore database object

The applicat ion m ap now con ta ins objects that represen t 
the Classics Adm in  m enu  com m ands.

Value f ield  for the 
ExerciseDuringMapping property

Value f ield  for the 
ExerciseDuringTesting property
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Mapping Classics to Full Depth

N ow that you have mapped alternative paths for the O rder It feature, created a 
region object for the unmapped album image control, and excluded the Restore 
Database menu command from mapping, you can map the Classics application to 
full depth.

To map Classics to full depth:

ã Right-click the Classics Online window object, point to M ap I t!, and then 
click Full.

Using the Find Objects Window to Locate Objects

If the application map that you create for your own application is complex, you’ll f
the Find O bjects window useful for locating objects quickly. In this exercise, you
use the Find Objects window to locate the View Existing Orders window objec
the application map for Classics.

To find the View Existing Orders window object:

1 . On the Standard toolbar, click Find O bjects.

2 . In the N am ed box, type View Existing O rders.

3 . U nder Type, select the Any U I object check box.

N O TE: This mapping session will take several minutes. While mapping is in 
progress, do not try to interact with your system.

Named box

Any UI object 
check box
44



Creating  TestFactory Reports
4 . Click Find N ow.

5 . To go to the View Existing Orders object in the application map, double-click 
the View Existing O rders item in the N ame column, and then close the Find 
Objects window.

The View Existing Orders window object is selected in the application map.

Creating TestFactory Reports

You can insert a TestFactory report object to configure and run a report on objects 
in the application map. Later, you can edit the report parameters, rerun the report, 
print it, and export it as a text file for editing in other applications.

Inserting a TestFactory Report Object
To insert a TestFactory report object in the application map:

1 . On the Insert bar along the left side of the TestFactory window, click Report.

To select the View Exist ing  O rders window in  the applicat ion m ap , double-click here.

Report bu tton on the Insert too lbar
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2 . To select a location (a parent object) for the report and open the Edit Report 
Parameters dialog box, click an object in the application map. 

Configuring TestFactory Reports
You can use the Edit Report Parameters dialog box to create three types of 
TestFactory reports; H ierarchy reports, Listing reports, and U I Checking reports. 
This exercise shows you how to configure and run a H ierarchy report and a 
U I Checking report.

Creating a Hierarchy Report
You can create and print a H ierarchy report to get a hard copy version of the 
application map hierarchy displayed in the left pane.

To create a H ierarchy report:

1 . In the left portion of the Edit Report Parameters dialog box, leave the H ierarchy 
icon selected.

2 . U nder Print O ptions, select the W indow bitm aps check box.

3 . To run the report, click O K.

N O TE: The application map location you choose for a report does not affect 
the report contents.

Hierarchy report icon OK button

Window 
bitmaps 
check box
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After running the report, TestFactory displays all of the application map objects 
in the right pane.

TestFactory inserts a report object below the object you clicked in the 
application map.

4 . To name the report, type a name in the active text box.

Creating a UI Checking Report
This exercise shows you how to create a U I Checking report. A U I Checking report 
provides information on mnemonics conflicts, incorrect alignment of controls, and 
other potential problems that TestFactory detects in the user interface.

To configure and run a U I Checking report:

1 . Insert a report object at any location in the application map.

2 . In the left region of the Edit Report Parameters dialog box, click the 
U I Checking icon.

In  the H ierarchy report, 
the nam es of ch ild  
objects are indented 
beneath  the nam es of 
the pa rent object.

TestFactory report ob ject

UI Checking icon
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3 . Leave all of the check boxes selected and click O K .

TestFactory runs the report and displays the results in the right pane.

The U I Checking report lists every control in the Classics user interface that might 
have a problem, the type of problem found, and the application map path to the 
object mapped for the control.

To jump to the object mapped for an item listed in the report, double-click its name.

Updating a TestFactory Report After an Application Changes
As changes are made to the application with which you are working, you can update 
an existing report by running it again.

To update a TestFactory report:

1 . Click the report object in the application map.

2 . On the Report toolbar, click Run Report .

D ouble-click here to  
jum p to the Classics 
Login object in  the 
applicat ion  m ap.

U I Checking report 
resu lts in  the right pane 

Report too lbar
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Exporting a TestFactory Report as a Text File
You can export a TestFactory report as a text file to edit in other applications.

To export a report as a text file:

1 . Click a report object in the application map.

2 . On the Report toolbar, click Export Report.

3 . Specify a report file name and a destination directory, and then click Save.

Printing a TestFactory Report
To print the contents of a TestFactory report:

1 . Click the report object in the application map.

2 . Click anywhere in the right pane of the TestFactory window.

3 . On the Standard toolbar, click Print .

Summary

By completing the exercises in this example, you’ve learned how to specify styles
string cases for input controls, use single-level and full-depth mapping to 
incrementally map areas of an application, use interaction objects to map altern
paths, create region objects for unmapped controls, create TestFactory reports
more. This practice will help you develop an accurate and complete map of your
application in TestFactory.
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What’s Next

N ow that you have incrementally mapped Classics to full depth, you can begin to 
test the application. The exercises in the next example show you how to run Pilots 
that generate scripts to test Classics.
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Automatically Generating Scripts

Objectives

ã Set up a Pilot to test the Classics Order It! feature, and run the Pilot on your 
local machine.

ã Examine the Pilot run results.

ã Insert and run Pilots to test other functional areas of Classics.

Scenario

In Example 2, you incrementally mapped Classics to full depth. To develop the map, 
you excluded a control from mapping and testing, assigned styles to input controls, 
and mapped alternative paths in the Make an Order feature. The exercises in this 
example show you how to run Pilots to test the application, and how to examine the 
Pilot run results.

Running a Pilot to Test a Functional Area of 
the Sample Application

This section describes how to insert a Pilot at the Classics Order It! button, specify 
the duration of the Pilot run in the Stop Criteria  tab, and then run the Pilot on your 
local machine to test the Order It! feature.

You’ll start by inserting a Pilot at the Order It! button in the application map.

To locate the Order It! button:

1 . Click Find O bjects on the Standard toolbar.
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2 . To clear the results of your last search, click N ew Search, and then click Yes to 
confirm that you want to clear the current search results.

3 . In the N am ed box, type O rder I t!

4 . U nder Type, select the Any U I object  check box.

5 . Click Find N ow.

6 . In the N am e column, double-click O rder It!

7 . Close the Find Objects window.

The Order It! object is selected in the application map.

To insert and set up a Pilot:

1 . In the application map, leave the O rder It! object selected and click 
Insert → Pilot .

Named box

Any UI object 
check box

Type O RD ERER here.
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TestFactory inserts a Pilot object at the bottom of the application map branch 
below the O rder It! window object.

2 . Type O RD ERER in the active text box for the new Pilot object, and then 
press EN TER.

3 . In the right pane, click the Stop Criteria  tab.

4 . To set a Pilot run duration of five minutes, leave Run for selected, and change 
the hh:m m  value to 0 0 :0 5 .

5 . To start the Pilot run, click Start.

After the run starts, you’ll see the following occur on the screen:

ã The TestFactory window closes.

ã The Pilot progress bar opens at the bottom of the screen.

ã A mask covers the screen and displays the Running Pilot message.

ã TestFactory starts Robot, and then minimizes the Robot window.

ã TestFactory starts and tests Classics.

Run for 
stop criterion

Start button

N O TE: For the Classics sample application, run Pilots for between five and
ten minutes. For complex applications, you would run a Pilot for up to 
several hours.
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During the Pilot run, the Pilot progress bar displays testing information.

Examining the Pilot Run Results

After the Pilot run is completed, the Summary tab displays summary run 
information in the right pane.

TestFactory’s TestMaker technology generates scripts that exercise as much o
application as possible. A single Pilot run generates a best script and a U I script. The 
best script provides maximum coverage of the application’s source code and u
interface using the least redundant script code possible. The U I script is design
exercise each and every control available to a Pilot just once. You can run the 
U I script later as a simple smoke test to check the controls in the user interface

If a Pilot uncovers severe program defects such as crashes, Visual Basic run-tim
errors, or assertion failures, it generates defect scripts that make it easy for you to 
pinpoint defective source code. If a Pilot encounters controls that aren’t mappe
that are mapped on a path other than the one the Pilot has taken, the run resu
include a U AW  (unexpected active window) script.

Stop bu tton

Run durat ion  so far

Specif ic act ivity in  progress

D efects found

U I coverage value

Code coverage value

#  of scrip t 
segm ents run

N O TE: Do not try to use the machine while the Pilot is running.

Percen t of ob jects availab le to  the 
Pilo t that the best scrip t touched

Percen t of source code in  the 
applicat ion that the best scrip t 
touched

Pilo t run du rat ion

Stop criterion  that ended the 
Pilo t run

N um ber of defects found
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To expand the Pilot run results folder and see the scripts your Pilot run produced, 
click Expand on the toolbar.

The scripts that the Pilot generated are in the ORDERER-Run-< date, time>  folder 
below the Pilot object in the application map. This Pilot run generated a defect script, 
a U AW script, a best script, and a U I script. 

In the following exercises, you’ll examine the scripts that the Pilot run generate

Don’t be concerned if your Pilot run results look somewhat different than the res
you see in the following figures. The Pilot that you run will take a slightly differe
path through the application. It will also exercise controls in the application usin
different random input.

Viewing the Outline for the Best Script
The script O utline tab lists all of the steps that a script took to test an area of 
the application. 

To view the steps that the best script took during the Pilot run:

ã Click the best script object in the application map.

TestFactory displays the steps in the O utline tab in the right pane.

Folder conta in ing the Pilo t run  resu lts

The Outline tab lists a ll o f the 
steps that the best scrip t took to  
test the O rder It !  feature.
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Viewing the Coverage Values for the Best Script
TestFactory calculates U I coverage values for all of the scripts a Pilot generates. If 
you run the Pilot against an instrumented application, TestFactory calculates 
code coverage for its best scripts and U I scripts. The coverage values indicate the 
thoroughness of testing and help you determine which features to test next. Code 
coverage tells you how well a script exercises the AU T and is an indirect indicator of 
the quality of the generated scripts. A Pilot calculates code coverage as it creates and 
runs new script segments. At the same time, it identifies and discards redundant 
script segments that do not increase code coverage. 

The Coverage tab displays the U I coverage and code coverage values for the best 
script. To see these values:

1 . In the right pane, click the Coverage tab.

The U I Coverage value shows the percentage of user interface available to the 
Pilot that the best script touched. The Code Coverage value shows the 
percentage of total source code that the best script exercised. 

2 . To see the code coverage values for every Classics source file, click the plus (+ ) 
character next to the Code Coverage item.

Click here to  see the code 
coverage values for a ll 
Classics source files.

Source files
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3 . To see coverage values for procedures in a source file, expand the source 
file item.

You can open the Coverage Browser window to see exactly how the best script 
exercised the source code for a procedure. 

4 . To view source code coverage details for a procedure in the Coverage Browser, 
double-click the procedure item listed in the Coverage tab.

5 . To jump to a specific line of source code, type the line number in the first edit 
box at the top of the browser, and then click Go To Line.

6 . To jump to the first instance of a text string, type the text string in the second 
text box at the top of the browser, and then click Find Text.

7 . To jump to the next line of source code that the script did not cover, click N ext 
N ot Covered.

Source file procedures

Classics source files

Coverage Text Colors 
button

Go To Line 
button

Find Text 
button

Source 
code text

Next Not Covered 
button
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The text in the Coverage Browser is color-coded so that you can see exactly what 
code the best script did and did not execute. 

8 . To see the current color coding scheme for source code text, click 
Coverage Text Colors.

Viewing the Test Log for a Defect Script
You can locate the exact line of script code that uncovered a defect in the sample 
application by opening the log for the defect script in the Rational LogViewer. 

To open and examine the log for the defect script:

1 . Expand the D efects Found folder.

2 . Right-click the defect script, and then click View Log on the shortcut menu.

The Coverage Text Colors d ia log box shows 
the cu rren t co lor coding schem e for code 
text d isp layed  in  the Coverage Browser.

D efect scrip t
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TestFactory starts the Rational LogViewer. The LogViewer displays the test log 
for the defect script.

3 . In the Log Event column, right-click the General Protection Fault item that 
has the failed result, and then click Properties on the shortcut menu.

4 . On the Log Event Properties dialog box, click the Result tab.

5 . U nder Additional inform ation, find the line number and source code file 
associated with the script failure, and make a note of them.

6 . Click Close.

7 . Close the LogViewer window.

After you determine the line number and source code file associated with the defect 
script failure, play back the defect script in Robot to reproduce the failure.

To play back a defect script in Robot:

ã In the application map, right-click the defect script object, and then click 
Play Back on the shortcut menu.

For instructions on debugging a script in Robot, see the Using Rational Robot manual.

General Protection Fault log event

The Additional 
information box 
d isp lays the source 
code file and line 
num ber associated 
with  the scrip t fa ilu re.
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Examining a UAW Script
If a Pilot encounters a window that isn’t mapped on the path it has taken, or if it c
see a window that it expects to see, then the Pilot generates a U AW  script. You can 
use a U AW script to trace the steps a Pilot took before losing its way in the applica
during testing. 

To examine the U AW script that the ORDERER Pilot generated:

1 . In the application map, click the UAW script.

2 . Review the steps displayed on the O utline tab in the right pane to determine 
what you can do to improve the application map.

If a Pilot generates a U AW script for a window or dialog box that you have not y
mapped, you can insert and set up an interaction object that lets the Applicatio
Mapper navigate and map that path in the application. This allows you to test the
path when you run a Pilot again in the same area of the application.

Identifying the UAW
To see what part of the Classics application generated the U AW script:

1 . In the application map, right-click the UAW script, and then click O pen on the 
shortcut menu.

2 . In Robot, click Tools → GU I Playback O ptions.

3 . Click the Log tab.

Output playback result to log 
check box

View log after playback
check box
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4 . U nder Log m anagem ent, select the O utput playback result to log and the 
View log after playback check boxes.

5 . Click the U nexpected Active W indow tab.

6 . Select the D etect unexpected active windows and the Capture screen im age 
check boxes.

7 . U nder O n fa ilure to remove unexpected window, click Skip current script .

8 . Click O K .

To run the U AW script and view the run log in the LogViewer:

1 . Click Go on the Robot Standard toolbar.

Detect unexpected active windows 
check box

Capture screen image check box

Skip current script option
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2 . Robot plays back the script until the UAW opens. After the script playback ends, 
the LogViewer starts and displays the log for the UAW script run.

3 . To view the properties of the unexpected active window, right-click the 
U nexpected Active Window item in the Log Event column of the LogViewer, 
and then click Properties on the shortcut menu.

4 . To open the Image Comparator and view a bitmap of the screen that includes 
the UAW, double-click the U nexpected Active W indow item in the Log Event 
column of the LogViewer.

The Image Comparator shows a bitmap of the Order Confirmation message 
box, which is represented in the application map. The message box was 
identified as an unexpected active window because the Pilot took a path in the 
application map that did not include the message box. The Pilot activated the 
message box by using random data entries to exercise controls in its path.

5 . Close the Image Comparator.

6 . After you finish viewing the log information for the UAW script, quit the 
LogViewer, and quit the Classics sample application.

If a Pilot generates a U AW script for a window that is already mapped, as happened 
here, you can disregard the U AW script. To decrease the incidence of U AW scripts 
such as this, you can decrease the percentage of random data entry used to exercise a 
control that accepts typed input. 

Unexpected Active Window even t
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 test 
Testing More of the Classics Application

N ow that you know how to set up and run a Pilot, run some more of them. Before 
you continue on to the next example, insert and run Pilots at the following 
destinations in the application map:

ã Classics Online window object

ã Customers menu object

Before you insert and run a Pilot at the Classics O nline window object, exclude the 
Inventory menu item from testing. The Inventory menu command in Classics 
activates the secondary application Inventory, which you have not mapped yet.

To exclude the Inventory menu item from testing:

1 . In the application map, click the Inventory menu object mapped beneath the 
Admin menu object.

2 . In the top right pane, expand the Pilot properties group.

3 . Double-click the Value field for ExerciseD uringTesting, and then click N ever.

Remember to set a five- to ten-minute duration for these Pilot runs. For information 
about setting the Pilot run duration, see steps 3 and 4 on page 53. 

After each Pilot run finishes, examine the scripts that the Pilot generated.

Summary

By completing the exercises in this example, you’ve learned how to run Pilots to
different functional areas of an application, and how to view the run results.

What’s Next

The next example shows you how to map the secondary application Inventory.
6 3
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Mapping a Secondary Application

Objectives

ã Include the secondary application Inventory in the mapping process.

ã Map a path in the Inventory user interface to full depth.

Scenario

An application can consist of a main application and a set of secondary applications 
that the main application loads and executes. A secondary application can be one that 
is developed as part of the application, or it can be a third-party application. Although 
TestFactory excludes secondary applications from mapping by default, you can map 
them in addition to the main executable file. The following exercises show you how. 

Mapping the Inventory Application

If a user logs on to Classics as a database administrator and selects the Inventory 
command in the Classics Admin menu, Classics loads and executes the secondary 
application Inventory. When you map an application that calls a secondary application, 
TestFactory maps the top level of controls it encounters in the secondary application, 
but does not map controls at deeper levels. To fully map a secondary application, you 
must add its name to the list of executable files on the Application M apper tab.

N O TE: If you want to test a secondary application and get code coverage results 
for the scripts your Pilots create for it, instrument the source code for the 
secondary application before you map it.
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To list the Inventory application in the Application M apper tab:

1 . Click Tools → O ptions, and then click the Application M apper tab.

2 . U nder List of executable files to map, click Add.

3 . To find the executable file for the secondary application from the Open dialog 
box, browse to the following directory:

…\Rational Test 7\Sample Applications\Classics Online\InventoryC.exe

4 . Click O pen.

5 . In the File list, leave the check box next to the file name selected.

6 . To save this addition and close the Options dialog box, click O K .

Add button

Leave th is 
check box 
selected.
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Mapping the Suppliers Feature of Inventory

When you mapped Classics to full depth in Example 2, TestFactory mapped the first 
level of controls in the Inventory application. Among the Inventory controls mapped 
during that mapping session is the Suppliers button. This exercise shows you how 
to map the Suppliers feature of the Inventory application to full depth. 

To view the first level of controls in Inventory, including the object mapped for the 
Suppliers button:

1 . In the application map, expand the Admin menu object to display the menu 
command objects mapped beneath it.

2 . Right-click the Inventory object, and then click Expand All on the 
shortcut menu.

3 . To see the Suppliers button highlighted in the Image view in the lower right 
pane, click the Button5 object in the application map.

4 . To rename the button object, click F2, and then type Suppliers in the text box.

When you first m ap Classics, TestFactory m aps only the 
top level o f con trols that it  encounters in  Inven tory.

After you specify the InventoryC.exe file for m apping, 
you can m ap  Inventory to  fu ll depth .

Button5  object

Button5  in  the applicat ion  m ap 
represents the Suppliers bu tton in  
Inven tory.
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To map the Suppliers button to full depth:

ã Right-click the Suppliers object, point to M ap It!, and then click Full on the 
shortcut menu.

To see the fully mapped Suppliers button after mapping is completed:

ã Expand the Suppliers object one branch at a time by clicking the plus ( + ) 
character next to each new object displayed.

You can use the Go To < Control>  in AU T  command to start Inventory and 
automatically navigate to the Suppliers button. You can then compare your mapping 
results with the Inventory user interface.

To start Inventory and go to the Suppliers button:

ã In the application map, right-click the Suppliers button object, and then click 
Go To “Suppliers” in AU T  on the shortcut menu.

Summary

In this exercise, you’ve learned how to map beyond the first level of controls in
secondary application that the main application loads and executes.

What’s Next

The next example shows you how to create a Test Suite and run the scripts it 
contains as a batch job on your local machine.
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Creating and Running a Test Suite

Objectives

ã U se the Find O bjects window to find scripts and create a Test Suite.

ã Run the Test Suite on your local machine.

ã Examine the results of the Test Suite run.

A Test Suite is the TestFactory object that you can use to organize scripts and other 
Test Suites, and run them as a batch job. The exercises in this example show you how 
to locate scripts from your Pilot runs, combine them in a Test Suite, and run the 
queued scripts on your local machine. 

Creating and Running a Test Suite

This section describes how to create a Test Suite using the Find Objects window, 
and to then run the Test Suite on your local machine.

To automatically create a Test Suite that includes all best scripts:

1 . On the Standard toolbar, click Find O bjects.
6 9
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2 . If the Find O bjects window displays the results of a previous search, click 
N ew Search, and then click Yes to confirm that you want to clear the results.

3 . U nder Type, select the Script  check box. 

4 . To start the search for scripts, click Find N ow.

5 . Press CTRL+  and click every best script listed.

6 . Click Create Suite.
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rent 

ripts 
U se the Select O bjects dialog box to choose a parent object for the Test Suite 
in the application map. The parent object that you choose doesn’t limit the
scripts that you include in the Test Suite.

7 . To choose a parent object for the Test Suite, click an object in the 
Filtered objects list, click Select, and then click O K.

TestFactory inserts a Test Suite object in the application map under the pa
object that you selected.

8 . Close the Find Objects window.

9 . To name the Test Suite, pressF2, and then type Best Scripts.

The Test Suite Status tab in the right pane lists the scripts you selected.

When you run a Test Suite on your local machine, TestFactory runs the sc
in the order in which they are listed on the Status tab. 

1 0 . To control the run order for a script, click the script name, and then use U p and 
D own to change its position in the list.

1 1 . To start the Test Suite run, click Start.

After the Test Suite run is completed, the values in the Status column show whether 
the script runs successfully completed or failed.

An U ntit led Test Suite object is inserted in  the applicat ion m ap.

The Status tab lists 
the scrip ts tha t you  
selected.
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Examining the Code Coverage Results for a Test Suite

To view the coverage results for the Test Suite and the scripts it contains:

1 . In the right pane, click the Coverage tab.

2 . To see code coverage for the source files, expand the Code Coverage item. The 
tree lists every source file in Classics and the aggregate code coverage values for 
the scripts that touched them.

3 . To see the coverage values for individual procedures within a source file, expand 
the source file.

4 . To open the Coverage Browser and view the source code for a procedure, 
double-click the procedure.

Summary

This example showed you how to use the Find O bjects window to create a Test Suite 
of best scripts, and how to run the Test Suite on your local machine.

What’s Next

The next example shows you how to use the AutoPilot to run multiple Pilots, scripts, 
and Test Suites as a batch job.

The Code Coverage item  shows the aggregate code 
coverage value for a ll o f the scrip ts in  the Test Su ite.

N O TE: For information about viewing code coverage information, see 
Viewing the Coverage Values for the Best Script on page 56.
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Using the AutoPilot to Run Multiple Pilots, 
Scripts, and Test Suites

Objectives

ã Start and add Pilots, scripts, and Test Suites to the AutoPilot window.

ã Run the test objects listed in the AutoPilot window on your local machine.

Scenario

The AutoPilot is the TestFactory tool that you use to run multiple Pilots, scripts, and 
Test Suites as a batch job on your local machine, or on Test Lab machines that have 
TestAccelerator installed on them. The AutoPilot helps you optimize your testing 
resources. You can use it to run test objects on your machine overnight. If you want 
to continue working on your local machine, you can use the AutoPilot to run tests 
on Test Lab machines. This example shows you how to run multiple test objects 
locally from the AutoPilot.
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Adding Test Objects to Run in the AutoPilot

To open and add test objects to the AutoPilot window:

1 . On the TestFactory toolbar, click AutoPilot .

2 . Click Find O bjects.

Find Objects 
button
74



Adding Test O b jects to Run in  the AutoPilot
3 . Select the Pilot, Script , and Test Suite check boxes, and then click Find N ow.

4 . Press CTRL+  and select a few of the test objects listed.

5 . To add these test objects to the AutoPilot window, click Accept.

6 . To change the run order for a test object, click the object name, and then use U p 
and D own to change its position in the list.
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ated 
Running the AutoPilot on Your Local Machine

To begin running the listed test objects on your local machine, click Start .

As soon as you start the AutoPilot run, the TestFactory window minimizes and the 
AutoPilot progress bar displays run information at the bottom of the screen.

After all of the listed test objects have been run, the AutoPilot displays the run result 
(Com pleted, D one, or Failed) for each test object.

To examine detailed run results for an individual test object, go to the object in the 
application map. To jump to a specific script, Pilot, or Test Suite in the application 
map, double-click its name in the O bject column, and then close or minimize the 
AutoPilot window.

Summary

In this example, you learned how to add a selection of the test objects you’ve cre
for the CLASSICS project to the AutoPilot window and run them locally.

What’s Next

The next example shows you how to set up a Test Lab machine running Rational 
TestAccelerator, and then run a Pilot on the machine.

AutoPilo t progress bar

D ouble-click here to select th is Pilo t 
ob ject in  the application  m ap.
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Running Tests on a Test Lab Machine

Objectives

ã Start and set up Rational TestAccelerator on a Test Lab machine.

ã Make the Test Lab machine available to the TestFactory machine.

ã Create a Test Lab machine group.

ã Run a Pilot on a Test Lab machine.

Scenario

As you develop more scripts, Test Suites, and Pilots, you can execute them on 
Test Lab machines running TestAccelerator. TestAccelerator is the agent application 
that manages the execution of scripts on the machines that make up the Test Lab.

Installing Rational TestAccelerator and Making the 
ClassicsC.exe File Available to the Test Lab Machine

To complete the exercises in this example, you must have already purchased 
Rational TestAccelerator and installed it on a Test Lab machine. For information 
about installing Rational TestAccelerator, see the Rational Suite Installation Guide.

From the Test Lab machine, you must have access to the exact same instrumented 
build of the ClassicsC.exe file that Test Factory uses. Before you start to set up 
TestAccelerator on the Test Lab machine, share the Classics O nline folder on the 
TestFactory machine. If you have access to more than one machine for testing, you 
can also install TestAccelerator and Classics O nline on those machines and include 
them in your Test Lab.
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Runn ing  Tests on  a Test Lab M ach ine
Starting and Setting Up TestAccelerator

The following exercises show you how to start and set up TestAccelerator on a 
Test Lab machine that has it installed.

Starting TestAccelerator
To start TestAccelerator:

1 . Quit all open applications on the Test Lab machine and leave them closed until 
you quit TestAccelerator.

2 . Click Start → Programs → Rational TestAccelerator → 
Rational TestAccelerator.

Rational TestAccelerator d ia log  box
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Start ing and Setting  U p TestAccelera tor
Working Offline in TestAccelerator
After you start TestAccelerator, the machine that it runs on is available to machines 
running TestFactory. A TestFactory machine running scripts in the Test Lab can 
take control of a Test Lab machine while you are setting it up. To prevent this, you 
can work offline in TestAccelerator.

To work offline after you start TestAccelerator:

1 . On the TestAccelerator dialog box, click the O ptions tab.

2 . U nder General, select the W ork offline check box.

Work offline check box
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Runn ing  Tests on  a Test Lab M ach ine
Specifying the Project in TestAccelerator
To specify the CLASSICS project in TestAccelerator:

1 . In the Rational TestAccelerator dialog box, click the Projects tab.

2 . Click Add.

3 . In the Project nam e box, type CLASSICS.

4 . In the AU T executable box, enter the path to the Classics Online folder on the 
shared drive of the TestFactory machine.

5 . Click O K .

Working Online in TestAccelerator
To work online in TestAccelerator:

1 . On the TestAccelerator dialog box, click the O ptions tab.

2 . U nder General, clear the W ork offline check box.

This Test Lab machine is now ready to work.

Project name box

AUT executable box

OK button
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Preparing to Test on a Test Lab Machine

N ow that you’ve set up TestAccelerator on a Test Lab machine, you can run P
scripts, and Test Suites on it from the machine running TestFactory. Before you
you first have to select the U se Test Lab machines option, and then create a 
machine group in TestFactory.

Making the Test Lab Machine Available to the 
TestFactory Machine

To make the Test Lab machine available to the TestFactory machine, you must 
the U se Test Lab machines option in TestFactory.

To select the U se Test Lab machines option:

1 . On the TestFactory machine, start TestFactory and log on to the CLASSIC
project in the Classics Repository.

2 . Click Tools → O ptions.

3 . On the General tab, under Global options, select the U se Test Lab machines 
check box.

4 . To close the Options dialog box, click O K.

OK bu tton

Use Test Lab 
machines 
check box
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Runn ing  Tests on  a Test Lab M ach ine
Creating a Test Lab Machine Group
When you run test objects on Test Lab machines from TestFactory, you can assign 
the objects to one or more machine groups. A machine group can include one or 
several Test Lab machines.

To create a Test Lab machine group from within TestFactory:

1 . To open the Machine Groups dialog box, click Tools → M achine Groups.

2 . U nder Group, click N ew.

3 . In the N am e box, type a name such as W in N T  or W in 2 0 0 0  for the 
machine group.

4 . Click O K .

The M achines available box displays the name of the Test Lab machine(s) that 
you set up for testing. 

New button

Name box
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5 . To add the Test Lab machine to the group, select its name, and then click Add. 

6 . Click O K .

If you have installed and set up TestAccelerator on additional Test Lab machines, 
you can add these to the machine group that you created or you can create additional 
machine groups for them.

N ow that you’ve successfully set up TestAccelerator and TestFactory, you’re re
to run remote tests.

Add 
bu tton

Select the 
m achine 
nam e listed 
here.
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for 
Running a Pilot on a Test Lab Machine

To run a Pilot on a Test Lab machine:

1 . In the application map, click a Pilot object that you created in the exercises in 
Example 3.

2 . Click the Setup tab.

3 . Select the U se Test Lab check box.

4 . In the M achine group list, select the name of the machine group that 
you created. 

5 . Click Start.

After you start the Pilot run, the Pilot progress bar displays run information at the 
bottom of the screen as the Pilot distributes scripts to the Test Lab machine. 
Although you can’t continue to work in TestFactory, you can use the machine 
other tasks during the Pilot run.

Once the Pilot run is completed, the restored TestFactory window displays 
summary results for the Pilot run in the Summary tab in the right pane. You can 
examine the Pilot run results just as you would if you had run the Pilot locally.

Use Test Lab 
check box
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Q uitt ing TestAccelera tor
Quitting TestAccelerator

To quit TestAccelerator on the Test Lab machine after testing is completed:

1 . In the status area of the Windows taskbar, right-click the TestAccelerator 
program applet.

2 . Click Exit  on the shortcut menu.

Summary

In the exercises in this example, you learned how to set up Rational TestAccelerator 
on a Test Lab machine, and then run a Pilot on the Test Lab machine from 
TestFactory.

For information about running Test Suites on Test Lab machines, see Chapter 6, 
Developing and Running a Test Suite in the Using Rational TestFactory manual. For 
information about running test objects listed in the AutoPilot on Test Lab machines, 
see Chapter 7, Using the AutoPilot in the Using Rational TestFactory manual.

What’s Next

The next example shows you how to set up the TestCodeChanges add-in for 
Visual Studio, and then use the add-in to test changes that you make to Classics 
source code.

TestAccelerator program  applet in  the 
status area of the taskbar.
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Testing Changes to Source Code

Objectives

ã Set up the TestCodeChanges add-in for Visual Studio.

ã Start Visual Basic and make changes to Classics source code.

ã Start the TestCodeChanges add-in.

ã Run scripts to test changed source code files.

Scenario

In this example, you’ll learn how to set up the TestCodeChanges add-in for 
Visual Studio and use the add-in to test changes that you make to Classics 
source code.
8 7



Testing  Changes to  Source Code
Setting Up the TestCodeChanges Add-In for Visual Studio

After you set up the TestCodeChanges add-in, it is loaded in your Visual Studio 
development environment where it automatically tracks changes made to the source 
code files for the open project.

To set up the TestCodeChanges add-in:

1 . Click Start → Program s → Rational Suite TestStudio → 
Rational Test → Set U p Rational TestCodeChanges.

The Information dialog box lists the Microsoft development environments 
detected on your system.
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2 . To continue with the setup, click N ext.

3 . To complete the setup, click Finish.

Changing Source Code in Classics

In the following exercise, you’ll change the source code for the Classics applica
recompile the ClassC.exe file, and then save the changed source files.

To open the ClassicC.vbp file in Visual Basic 6:

1 . Start Visual Basic 6.

2 . In the N ew Project dialog box, click the Existing tab.

3 . Browse to the following directory:

\\Rational\Rational Test 7\Sample Applications\Classics Online\classics sou

4 . Open the ClassC.vbp file.

To change Classics source code:

1 . In the Project window, expand the Forms folder.

2 . Double-click frmM ain.

3 . On the frmMain form, click the Order It! button object.

4 . In the Properties window, locate the Caption property, select the current value
(Order It!) and type O rder N ow!

5 . In the Project window, double-click frmO rder.
8 9



Testing  Changes to  Source Code
6 . On the frmOrder form, click the Place Order button object.

7 . In the Properties window, locate the Caption property, select the current value 
(Place Order) and type Subm it O rder.

To make the executable file and save the project:

1 . Click File → M ake ClassicsC.exe.

2 . In the Make Project dialog box, click O K .

3 . To confirm that you want to replace the existing executable file, click Yes.

4 . To save your changes and the ClassicsC.exe file, click File → Save Project.

Testing Changes to Source Code Files

N ow that you’ve made changes to Classics source code, you can start the 
TestCodeChanges add-in and run scripts that test the changed files.

Starting the TestCodeChanges Add-In
To start the TestCodeChanges add-in and log on to the CLASSICS project:

1 . On the Visual Basic toolbar, click TestCodeChanges.

2 . In the Rational Repository Login dialog box, click O K.

All changed pro ject 
f iles are listed in  the 
left pane.

Scrip ts that exercise 
the changed  f iles (and 
that have code 
coverage values) are 
listed in  the right pane.
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The Changed files list displays the names of all of the changed source code files and 
the date on which each was changed. Changed files are listed in descending order of 
the date they were changed, starting with the most recently changed file. 

The Scripts that exercise changed files list displays all of the project scripts that 
exercise the files listed on the left, and for which TestFactory calculated code 
coverage. The value displayed in the Percent column indicates the percent of source 
code in the changed file that the script exercises. If a listed script exercises two or 
more of the changed source files, then its Percent value represents an average percent 
of code that the script exercises in all of the changed files it touches. 

The order of a script in the list is based on the amount of code coverage it provides 
for the changed file relative to the other scripts. The script that provides the highest 
code coverage is listed first. 

To add a script that does not exercise a changed file, or does not have a code coverage 
value, to the regression suite:

1 . To view all available scripts, click Show All Scripts.

The Available Scripts dialog box lists all of the scripts that you can add to the 
regression suite.

2 . To add a listed script to the suite, click the script name, and then click Add.

3 . To add a multiple scripts, hold down the CTRL or SH IFT key, select multiple 
script names, and then click Add.

4 . The add-in runs scripts in their listed order. To change the run order for a script, 
click its name, and then use U p and D own to change its position in the list.

All o f the scrip ts that you can add to the 
regression su ite are listed in  the 
Availab le Scrip ts d ia log box.
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Testing  Changes to  Source Code
5 . To start testing your code changes, click Run.

After you start the run, the add-in window closes, Robot starts, the AU T starts, and 
the Script progress bar displays testing status at the bottom of the screen.

Viewing Run Results
After the regression suite run is completed, the Status Report dialog box displays the 
run status for each script in the Status column. A Com pleted status indicates that 
the run completed and that the script encountered no defects. A Failed status 
indicates that the script encountered one or more defects (unless the script run was 
interrupted).

If the run results for scripts that exercise a changed file for your project are 
successfully completed, you can check in the modified code. If a run result fails, 
examine the logs, make necessary changes to the source code, and then rerun the 
regression suite.

To close the Status Report dialog box and quit TestCodeChanges, click O K .

Summary

In these exercises, you used the new TestCodeChanges add-in to access and run 
scripts that tested changes you made to Classics source code.

Run results for scrip ts in  the regression su ite
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